You can find the free reference images in the resources folder that accompanies this eBook.
**Painting Myths & Legends**

**Chapter 01**

**Griffin**

**Software used:** Photoshop

**Introduction**

As part of the series about creating photoreal fantasy creatures I was asked to create an image of a fantasy beast called the Griffin in what could be its natural habitat. It is a creature that is half eagle and half lion, and I decided to illustrate it guarding its roost.

My tutorial brief required me to incorporate some photographic reference use, but a large portion of my art was manually created with nothing more than some simple brushes. Hopefully you find the process enlightening and enjoyable - let's get started!

If you know me, or have read any of my prior tutorials, then you'll know what I am going to begin with – doing research! It’s important enough that I pretty much add this section before every tutorial and it’s not just to pad out the word count I can assure you! It is just that important.

Whether you know or understand the subject matter intimately or not, you need to fill your consciousness with new information on a consistent basis in order to provide fresh ideas or you run the risk of growing stale and creating highly derivative art.

What does this mean in a practical sense? Well, in today’s age of blogs, online articles, image archives, forums and the like this essentially means jumping on the internet and using your favourite search engine to source out some visuals to kick start your engine. Some of my favourites are listed below – it certainly isn’t exhaustive, but these are typically all I need to find good reference:

- [http://www.google.com](http://www.google.com)
- [http://www.flickr.com](http://www.flickr.com)

If you don’t have the internet then it means a little more leg work. Going to your local library, picking up a newspaper, magazine, trade journal or watching a movie and stock-piling your mental arsenal from there is a good start.

Whichever resources you choose to draw upon, just make sure you use them as inspiration only and don’t plagiarise the work. That would be unscrupulous and does not help your skill level grow; indeed it will more likely lower your confidence in your own abilities.

Back to the griffin! Let’s begin with a very rough pencil sketch in order to compose the layout of the final picture (Fig.01).

You'll notice that in my sketch, I leave a lot to the imagination; a few scraggy lines denote an ice mountain range, a few scribbles underneath the creature’s head mark the position where I will illustrate a nest. The important thing to keep in mind at this stage is balance - does the image seem balanced? If not, shift some elements around until it does. Often it takes a bit of trial, error and experience which you only get from getting down and dirty.

This process of shifting elements is facilitated by rough abstract shapes and I only put in details where I need to work something out.

You can observe in my sketch that the face/beak area is where I’ve spent some time adding extra details because this will be the area of focus. That being said, it is still quite rough and will undergo quite a lot of changes as the image progresses.

Create a new layer set to Multiply and drop a cool mid-tone. I have chosen a mid-tone cool hue wash as it allows me to better gauge my
highlights and shadow and because I also want a predominantly cool image (Fig.02). I have also started to paint in some darker tones to denote form and establish an idea of where the key light should probably be coming from. During this phase of the illustration, I am using the Soft Round brush that comes standard with Photoshop. This brush allows me to block out large swaths of tone and stops me from starting on the details too early in the process.

Using the mid-tone as a good starting point, paint in the darkest tones and the brightest highlights coming from the sun (which is outside of the image). You can also see that I’m starting to tighten the rendering around the facial area relatively quickly to establish a baseline quality against which the rest of the image will be judged. In particular I am beginning to alter the silhouette of the head and add more weight to the bottom of the griffin’s lower beak to counterbalance the heaviness of the top part of the head. In the background, start to drop in some darker tones to show shadow areas on what will eventually become big ice shards/mountains (Fig.03).

Once you’re happy, press Ctrl + Shift + Alt + E to create a summary layer of all the layers underneath. Next we’re going to begin a process of lassoing and shifting various picture elements around. I have darkened the underlying image on the left to show you the two main areas I am repositioning - the eye and the ear (Fig.04).

We don’t want to concentrate all of our efforts in one area, so I’m going to begin building up the surrounding elements to allow the image to advance as a whole. This allows us to judge whether it is progressing in the desired direction. In particular, start putting in the highlights on the ice in the background and adding more line work design to the wing area. I am using a combination of the Soft Round brush and a custom Chalk brush I have created that simulates the feel of drawing with a pencil (Fig.05).
Concentrating on further refining the available details, add some ambient shadow to the base of the ice shards. As they are semi-translucent, the base should be the darkest and they should lighten as they taper off into a point towards the top as they are thinner and allow more light to pass through them. At this stage, we can also start adding some analogous colours, mostly a turquoise blue to the tips of the ice (Fig.06). Don't go overboard with color usage, just hint at it to test out if it will work. We can increase the saturation later on if it feels right.

Start to define the form of the head a little more, especially the upper beak as this will be a major point of focus. The tongue feels a little stiff and lifeless to me so I'm going to introduce a little bit more rhythm to it. After all, this is a wild animal and I want all aspects of the creature to emphasize this fact. Towards the top of the griffin's neck, taper it off and increase contrast by adding darker tones to the image.

You may find there are a few harsh areas of areas that could do with being toned down. We want to make sure the viewer's eyes is not distracted by too many points of interest or contrast - particularly the inner membranes, which have a harsh, thick, white light. This might be something I eventually work back in, but for the moment let's paint it out as it's messing with my evaluation of the overall work.

Working on the form of the neck, treat it as more of a cylindrical object and darken the underside, as it would receive less illumination with the lighting setup that I have chosen to go with (Fig.07).

At this point, I've decided that I will be relating my tonal rendering to two major light sources - the harsh rim light from the left of the image (the sun) and a slightly less harsh fill light from the front, which will act to illuminate the forward facing details of the griffin. On the ice cliffs in the background continue to add darker tones and on the tips begin to simultaneously add more lighter saturated turquoise. You can see how quickly the ice takes shape just by laying in the correct values in the right place.

Creating a new layer set to Color, lay in some darker pinks for the ear canal, tongue and membrane area (Fig.08).

Notice that I haven't completely covered the blue undertones; this is because I am trying to preserve that blue throughout the image as a unifying tone that will tie disparate colors together.

Next, add some darker oranges and some yellow to the beak, again using the same layer set on Color blend mode.

Wanting to give a feel that the beak is semi-translucent (similar to the ice) let's add some
lighter yellow tones to the external thinner parts of the beak. The effect is over-exaggerated for the moment, but it gives nice dimension to the feature. We can tone it down later on (Fig.09).

It is probably apparent, but I thought I would mention it here: the method in which I work relies on controlling the pushing of boundaries and correcting mistakes. I don’t pretend to know exactly how the image will turn out from the outset, but for me that is half the fun!

In order to break up the image, create a new layer set to Multiply and paint in some darker tone (Fig.10). This starts to create some differentiation between components of the image. At this point, I am still unsure as to what colour I want to have the sky, but the dark tone allows me to better judge the ice shards.

Using the Ctrl + Shift + Alt + E command again, flatten out the layers and use the Lasso tool to select the area around the ear. Move the ear inwards, closer towards the eye, as I feel it makes a nicer trajectory between the eye and the tip of the ear and looks a little more streamlined (Fig.11).

Using white, we can also add some more highlights to the tiny feathers around the eye socket. Then, using a custom smoke brush, I’m adding more vapour coming out of the creature’s mouth to give the idea that this is a cold region.

This step (Fig.12) is really just a continuation of the previous step: taking the newly copied layer information and, using a Soft Round brush, erasing the sharp edges in order to blend it into the existing background.
The beak’s shape isn’t that pleasing to me, so let’s scrap a lot of the internal detail by painting on flat color and also re-sculpt the area that connects to the nostril area to make it more streamlined (Fig.13).

Around the top part of the head and along the neckline, add some white to denote the rim lighting and differentiate the griffin’s head from the background.

Being relatively happy with where most of the elements are, I’m going to move on to working on the form of the creature. Choosing a dark tone, close to black, I add more tone around the eye area in order to push the eye inwards (Fig.14).

Also darken the base of the ice shards and the wing, and bring out the ear and some of the feathers as well. I’m using a Soft Round brush for this as I find it is perfect for working on ambient occlusion-type shadows.

Creating a new layer set to Colour, lightly paint in some orange tones to introduce some complimentary color to the image and help pull the griffin away from the background (Fig.15).

The nostril area isn’t looking that good so let’s do a little redesigning. Sculpt the shape out of existing highlight, mid-tone and shadow colors already present on the beak so that you don’t need to pick new colors (Fig.16).

I also start to cut down the amount of Sub-Surface Scattering; this is the amount of light that passes through the material of the beak. We do this by painting the lighter areas a little thinner. To bring out the depth of the eye, increase the highlights around the outside of the eye socket, thereby increasing the contrast.
Finally, start blocking out the wing colors a little more, concentrating on the large swaths of dark tone rather than any details.

I’m going to work on the sky next, but instead of painting all the details, let’s use a free texture from: http://freetextures.3dtotal.com. Fig.17 shows the image I’m using, brought into the griffin illustration with no alternations.

Set the Blend mode to Overlay, alter the Opacity to 76% and add a new Vector mask by going to Layer > Vector Mask > Reveal All. Using black, paint out the areas of the sky that are not required (Fig.18).

Using a Soft Round brush, brush on a very small amount of white across the sky area. This simulates a bloom from the sun that is outside of the picture frame (Fig.20).

Next add a layer mask to this Adjustment layer (like in the previous step) to hide the areas that do not need brightness adjustment, which is everything apart from the sky. I’m using a Highlight value of 154.

Using a Chalk brush, I also rough in the twigs of the nest to make sure that it will compositionally work well with the existing picture elements.

Using a smaller brush, start to refine the details. I’m using a small version of the Soft Round and make sure to zoom into the image (Fig.21). In particular, pay attention to adding more highlights around the eye and using the Soft Round brush to smooth out the textures.
Using highlights, we can also create a sense of depth and wetness to the eye region and add a few scratch marks that may have resulted from a fight with another wild animal. On the clouds I use an Overlay layer, a Soft Round brush and again paint in some white bloom around the left rim of the cloud masses to indicate where they are being lit from.

In order to increase the feel of this creature being of the wild, block in ruffled feathers to the back of its head and neck, similar to those found on some species of eagle (Fig.22).

Zooming in once again, I’m using a very small Hard brush to work on the tiny feathers around the face and neck that will help sell the image.

We can also use a Soft Round brush with white to smoothen out the area beneath the ear.

Moving on to the twigs, color-pick the established colors and begin to refine them into branches of a tree. I brush a little of the background blue onto some of the branches to give them a sense of depth.
Now let’s add an egg! Start painting in a partial oval (Fig.23). At this stage we only need to block it in with a little hint of the light direction. I’m using a Soft Round brush for this and warm, desaturated tones to create the block-in. Using a very small brush I also begin to add minute strokes to the feathers on the wings to imply detail.

Concentrating on the egg, zoom in and use the Soft Round brush to increase the amount of detail and sharpen the rendering (Fig.24). To establish more form, push the darker values, making it seem more oval in shape.

Begin the block-in of the talon using a Chalk brush (Fig.25).

Choose a bright yellow similar to the highlights on the beak. Apply only slight pressure so that the colors optically meld together.

Darken the background of the ice region with a Multiply layer. This is done to increase the contrast between the background and the griffin, which is the main subject in the image (Fig.26).

Begin to add highlights and also darken the talon and claws. Add highlights to the claws, making sure to follow the form and thinking about where the reflected light would be on the
claw. Zooming in, refine the claw and make sure to use a high-res photograph as a reference for the details (Fig.27).

Finally, let’s add a little bit of atmosphere in the form of falling snowflakes on a separate layer, which you can paint with a combination of a Soft Round brush and applying Motion Blur (Fig.28).

**Darren Yeow**

For more information please visit:
http://stylusmonkey.carbonmade.com
Or contact them at:
darren@stylus-monkey.com
Giant

Software used: Photoshop

Introduction

The aim of this tutorial was to produce an image that looked like a convincing photograph of a creature that does not exist in reality, but perhaps could have resided somewhere in the world. I imagined a scenario in which a rare snapshot has captured a unique glimpse of a mythological creature. Before starting this painting I recalled photos I had seen as a child relating to Bigfoot and the Loch Ness Monster and their alleged existence. The pictures lacked any real clarity, suggesting they were perhaps hoax photographs. I had already chosen a giant as my topic, but needed to decide on the context and environment. I initially thought about a mountainous habitat and then considered the jungle as this would be a great place to remain elusive and hidden from civilisation.

Thumbnail Sketches

With a jungle theme in mind I started making some small sketches to work out the composition. I considered a river with a large silhouetted figure strolling across the valley floor, with perhaps some characters in the foreground. Fig.01 shows a few variations on this theme with the viewer looking down river and catching sight of a wandering giant. I experimented with some sand banks where the characters could be positioned, but somehow the jungle environment did not feel right. I then considered a misty forest in the foothills of a mountain range where visibility would be restricted and hence make for an ambiguous photo, although this seemed a little clichéd. I began thinking of more unusual environments and the one which seemed less obvious was a desert. This isn’t the greatest place to hide but they can be vast and inhospitable, therefore providing a remote environment for a giant to exist away from mankind. I imagined the creature venturing out from his canyon habitat in search of food or water and happening to be caught on camera by an unsuspecting photographer attached to a small party of men.

Blocking In

Fig.02 shows my initial block-in, with the giant striding past a rock formation. I planned on eventually situating the men in the foreground sheltered behind the rock, with the photographer being in the extreme foreground behind the camera. During this stage I built up the image in three distinct layers: the foreground, including
the rock and sand, the sky and finally the giant. Keeping these three sections separate meant that each aspect could be modified easily throughout the painting process. Because this task involved creating an image that might be interpreted as a photo it required some actual photographic elements borrowed from a matte painting approach.

**Using Photographs**

Fig.03 shows a sample of photos I took from 3DTotal’s free library: [http://freetextures.3dtotal.com/](http://freetextures.3dtotal.com/). The two rock images can be found under Nature > Rock, with the sky being located under Nature > Skies. The two rock images were color corrected to match and then scaled and rotated to fit the painting. The sky was also desaturated slightly and pasted in behind the giant and foreground.

I found the image of a distant rock outcrop, which I used to add some background scenery (Fig.04): [http://freetextures.3dtotal.com/preview.php?imi=8326&s=c:Rural_Environments&p=0&cid=17](http://freetextures.3dtotal.com/preview.php?imi=8326&s=c:Rural_Environments&p=0&cid=17).

Using further sections of rock I built up the foreground and then pasted in two palm trees from the reference library (Fig.05). The sand in the immediate foreground was built up from three photos, with the two principal ones visible in Fig.06.

When using photographs it is important to color adjust them so that they match closely. My first port of call was Image > Adjustments > Brightness/Contrast, followed by Image > Adjustments > Color Balance. Once the photo elements were in position they were blended together using a combination of the Clone Stamp and Eraser tools.

Up until this point I’d only really worked on the foreground area and so it was time to address the giant and add some definition. I found an image of a man wearing some ragged-looking clothes in the medieval section of the library and thought this would make an apt reference. Fig.07 shows the original photo and its new location in the painting. Because the giant is meant to be some distance from the camera I reduced the contrast by way of Image > Adjustments > Curves and then added some highlights across the shoulder to blend him in with the scene lighting.

The scale of the rocky outcrop looked too small compared to the palm trees and so I decided to move this section into the middle distance and re-do the foreground. Fig.08 shows the new outcrop and the three photos that have been
used from the reference library to start building the detail into the giant. You can see that I have made up the arm from two photos, the forearm from one and the hand from another (right inset). The upper arm was extracted from a third one, which you can also see in the lower part. All three images were taken from the Medieval > Civilian section of the library. Whilst browsing through the reference library I came across a German military vehicle and instantly decided to use the theme of warfare and maybe even suggest some bizarre military experiment.

I wanted to set this picture somewhere in the past, as mentioned in the introduction, and having recalled a TV series about World War 2 that was retouched in color, I thought this would be ideal. I imagined this to be a retouched photo from that period, which allowed me to make it look old and therefore suggest a sense of doubt about its authenticity. I promptly pasted in the vehicle in question and then added in two soldiers in the foreground.

The face was roughed in, but given the scale and distance of the character it only really needed to read tonally as opposed to incorporating any real detail. Here is the detail of the giant’s head, which you can see is vague and lacking any real clarity (Fig.09).

Bringing Everything Together

At this point all of the crucial components were in the image and it was time to gel everything together and add the final touches. The first thing I needed to do was add some motion blur to the giant as he would be taking large strides across the landscape. To do this I duplicated the layer and went to Filter > Blur > Motion Blur. I then reduced the opacity to around 50% and rotated it slightly (Fig.10).

I didn’t want to blur him completely, but rather focus on the areas that were moving the most, such as the arm and head.

I repositioned the soldiers and vehicle and then added a Curves > Adjustment Layer to add some highlights to the palm trees (Fig.11). This is done by going to Layer > New Adjustment Layer > Curves. After this I adjusted the curves to make the trees lighter. I then used black to paint into the mask (see highlighted thumbnail) to restrict the highlights to just the left sides. You will also notice that I added some dust to the vehicle and soldiers courtesy of a new layer of color set to Overlay.

I added two new adjustment layers – Curves and Levels – in order to add a brighter light into the image. Once applied, I painted into the masks to control the effect as well as painting in some sun glare (Fig.12).
Image Adjustments and Filters

At this stage I flattened the layers and then applied a Film Grain filter (Filter > Artistic > Film Grain), as seen in Fig.13. I then used some dirt maps to add an edge around the image akin to old photographs. I inverted the map, moved and scaled it accordingly and then set the opacity to around 40% (Fig.14).

To add some scratches and imperfections I sampled other dirt maps and set the blending mode to Color Dodge at 80% opacity (Fig.15).

To add some color tinting that will help give it that retouched quality, I applied another dirt map, which I partially erased and then set to Soft Light at 60% opacity (Fig.16_1). I then applied a Photo Filter, which can be found under Image Adjustments; in this case a Warming Filter. This essentially balances the light and adds a warm yellow tint, which helped to age the image (Fig.16_2).

The third adjustment I made was courtesy of Image > Adjustments > Exposure. I used this to add a further contrast, which is often a quality seen in older photographs where there is a slight overexposure (Fig.16_3).

Perhaps the last key aspect to add for a little more authenticity was a vignette – a feature of early photography caused by lens limitations or deliberate camera settings. To do this I created a new layer and filled it with white. You then need to go to Filter > Distort > Lens Correction and reduce the Vignette amount (Fig.17). Once done, this layer can be set to Multiply blending mode and voila!

With this last adjustment the image is complete – a color retouched photo from another era capturing a rare glimpse of a giant as he strides through the deep desert.

Richard Tilbury

For more information please visit:
http://www.richardtilburyart.com
Or contact them at:
ibex80@hotmail.com
Today we are going to paint an unreal creature, a dragon, to be exact, and place him in a realistic scene to make him look believable and real. Before we begin with the scene we have to design our creature. Dragons are a common subject matter within art, so it is important to design them from scratch. You may say, “why should we design it from scratch?” I think it is the first step towards making it original and believable.

What makes something believable? This is an important question and we will follow a couple of steps to develop our flat drawing into a realistic being.

**Base Drawing**

What we have here is nice fella, but he isn’t very realistic is he (Fig.01)? Why? Because we do not come across many cartoon creatures! What we do meet a lot of, however, are birds, dogs, cows – perhaps even more – and all these are creatures that can be looked at and we can work out how much they weigh, what color they are etc. We can also work out what they eat and how they move.

Our first step into creating our realistic creature will be to transform our fantasy being into something we can relate to real things. We have to rebuild the dragon’s anatomy so it looks like some of the creatures walking and breathing on our planet. The art of creating great fantasy creatures is to keep them a balance between unlimited fantasy and pure biology.

Do you think Fig.02 is any better? That is not the best dragon design you have ever seen, but it is definitely more realistic. Our client should be able to tell how evolution created this kind of creature. Even if our target is pure fantasy we should still give it real-world features. For example, if you are painting creatures living on an alien planet, you must understand that alien planets have very physical aspects; after all, the entire universe is built out of the same material. Let’s say our creature lives on Mercury. It may have thick skin, no eyes because of strong sunlight or armored feet to walk through acid rivers. But it is rather less probable it has nine wings or wheels instead of legs.

Another example is deep ocean creatures. They look weird, but still they have the same anatomy features as mammals or regular fish. Species may develop different forms depending on their environmental conditions, but when it comes to anatomy they are all the same: bone joints, muscles and skin. Relating our fantasy creature to real animals is the best way to make it convincing.

**Making it 3D**

Since we are 3D creatures living in a 3D world, everything that is flat doesn’t seem real enough. Our dragon so far is pretty realistic, but still kind of cartoony. Let’s change that by taking it into 3D. What determines if an object looks 3D or 2D? Shadows (Fig.03 – 04)! Ok so now we are ready to believe it is a real creature. It is quite convincing, but still needs a final touch.

**Color**

Since we do not see many line art grayscale creatures around us, we need to bring our dragon into the color world. Once again, even with a fantasy creation we should still keep it reasonable and make sure it relates to our world. Let’s see why (Fig.05). Beautiful isn’t it? But be honest, would you ever believe in a creature with that set of colors? It looks like
a pretty rare combination to me. What we are trying to do here is make it easier for your eyes to accept that this is a dragon. Let’s see some more combinations that are perhaps a little more natural (Fig.06 – 09).

As you can see, our creature will look much better in toned, dirty earthly colors and in a limited palette. In this world every creature is trying to blend into the environment it lives in. But as you can see, even in this narrow palette the amount of possible color combinations is countless, and this is how nature is.

**Match the Creature to the Situation**

What is left is to place our imaginary creature in the real world. To keep it realistic you must focus on a couple things. Perspective; we humans see the world in perspective and it is basic logic to show this in a picture. Everything further away is smaller and everything that is nearer is bigger. If we want the scene to be realistic we must reflect some sort of perspective. In this case we use a low point to make it look more dramatic. Right, now we can see the entire situation with the “victim’s” eyes!

The next step is the palette. Use natural colors. In the real world there are more bluish and greenish colors than red or pink tones. Of course they still exist and you should use them, just keep the overall tone in between the green and blue area.

Reflecting realistic lighting is critical, and adds to the feeling of the scene. The key to this is to be a patient and good observer. This is not easy to understand and you can’t understand all existing light phenomena, but it is worth a try!

The atmosphere also has a large impact. Haze, distance, fog and air density all help a lot to make the scene believable and realistic (Fig.10).
When creating realistic fantasy illustrations, what we should firstly pay attention to is the design of the key elements. The features of the subject cannot be too exaggerated and must follow the same laws as similar items in reality. If you do not do this it won’t look real regardless of how well it is painted. By basing features on reality it will make the subject far more believable to its audience.

For example, the main character of this image is the Yeti, which is a mysterious animal that is a cross between a man and an ape in the legends. It is strong and tall and hides among the Himalayas. Since these features have already made an impression on people in other depictions, we should think cautiously about how we can improve and build upon the features.

First, make a sketch of the character as a reference before creating the illustration. Based on the description and various data I collected, I created this prototype of a Yeti (Fig.01). Walking upright, it is strong and hairy with a similar form to that of man. It also has to look fit as it’s been living in cold, snow-covered mountains.

Using the sketch of the Yeti as a reference you can draw the preliminary draft of the illustration. In the case of my image I adopted a more traditional form of composition: I put the main character in the center of the image and combined some close-up and long-ranged features to expand the structure of the picture.

I used snow-covered mountains and a Tibetan-style deserted village as the background to give the impression that the Yeti is in the Himalayas. The main character is howling in pain after being shot. I added this so that there was a sharp contrast between its tall and strong appearance and its apparent vulnerability. By doing this the illustration became filled with story details and in turn will become more impressive (Fig.02).

Using your preliminary draft it is time to get into the formal painting. Firstly arrange the character so it is in perspective with the rest of the scene. It is important to adjust the position and proportion at this point because if you don’t then it can cause you a lot of problems at a later stage. Also spend a little time correcting and adjusting some of the organic and expressive details as they will form a solid base for the rest of your character.

It is really important to take time to look at your images and, whilst studying the preliminary draft, I concluded that the background didn’t reflect the visual effect of a towering snow-covered mountain that I wanted it to. The extensive clear sky didn’t re-enforce the fact that...
it is snowing in the illustration. Also there was a big problem in the perspective of the mid-ground village buildings. It is best to make corrections now rather than later, so I added the mountains to strengthen their visual impact. I also changed the angle of the buildings in order to make it look as if the illustration was being viewed through a fish-eye lens. This adds to its photographic appearance (Fig.03).

The next step, as always, is to start to refine things. The scenery can be put on hold for the time being as the structure is already in place. As the main character is the focus of the picture it needs more detailing, particularly for the face, hair and muscle structure (Fig.04).

If we were creating this as an ordinary illustration, we could continue to hand-paint the image until we had the desired effect. But what we want is a realistic illustration similar to a photo, so extra brushwork and hand-painting is unnecessary. What we will do is overlay details using photos that we can match and blend to the image. So for now we can take a break from hand-painting everything. First, let’s start with the Yeti. In order to observe the changes better remove the background; this should help you see the detail.

Because the Yeti lives and hides in the snow-covered mountains, it would have white hair as camouflage. This instantly makes us think of a polar bear, whose characteristics are similar. You can use the photo references to add the hair, making sure you match the photo with the direction the hair would grow. Once you have taken a clipping of your photo you should re-size and twist it, if necessary, to match your painting. In the case of my image photos covered 80% of the painting. I used Overlay and Soft Light blending mode to add the images (Fig.05). The pictures are from 3DTotal’s helpful resource site, which can be found here: http://freetextures.3dtotal.com.
Continue to refine the Yeti after overlaying the hair. It is important to recover the shadow effect, which may have been weakened by overlaying images (Fig.06).

Next you can turn your attention to the background environment. This, however, is different from the method used on the Yeti because the clarity and accuracy doesn't have to be quite as sharp, due to the fact that it is further in the distance. You will need to put the photos together in the image and replace the scenery you painted earlier. Compared to the hair where things could be twisted and manipulated, it is quite hard as it is difficult to find buildings and scenery where the angles are similar to those in the painting.

The adjustments to the scenery should be carried out in layers from the back to the front, starting with the details that are furthest away. So to start with I worked on the distant mountains in the background. I chose two pictures where the shapes were similar and put them together. While choosing the photos you should pay attention to the unification of the light sources. When putting the images together you can make color corrections and adjust the contrast to make it all tie together (Fig.07).

Once this is done, start putting together the photos that will make up the mid-ground in the same way as before (Fig.08). As you can see I have taken features from image A and put them on top of the rocks in image B. When that was done I added snow cover by overlaying image C in Overlay mode.

As you can see, it is impossible to find all the resources you need with the correct angles applied and with the correct colors and lighting. The only way to make it appear as it did in your concept is to use color adjustments and hand-paint any missing features. The perspective can be adjusted using Free Transform or Liquify.

Once I had done that I added more of a story to the image by adding more snow cover and a corpse in the front of the painting. Once this is done, you will no longer require any further photos resources. That's all for the use of the source materials. Although it still doesn’t look like a photograph the gap has been bridged drastically by the use of carefully...
placed and adjusted photographs (Fig.09).
Again the photos here were taken from: http://freetextures.3dtotal.com.

Now let’s move onto making the final changes. First it is important to make sure all of the different features are integrated. It can easily look disjointed when a lot of photos have been used. It is also important to correct any areas where the light and shadow may have been adjusted when overlaying images, as mentioned earlier.

This is also the stage where details can be added to build upon the atmosphere of the image. I did this by adding snow to the area where his feet meet the ground. I then added blood to his chest, arms, hands and face. I also added to the windy/stormy feeling by painting in the flags blowing around in the background.

Another important thing to do is blur the scene behind the Yeti, gradually making it less clear from front to back and therefore showing depth of field. I did this using Gaussian Blur in Photoshop (Fig.10).

Finally, add the wind and snow effect. Because of the strong sunlight in the painting, the snow is clearly seen in the foreground as it is blown from the buildings and rocks. The density of the snow shouldn’t be too high and you can make it look more dynamic by using Motion Blur, as you can see in Fig.11.

The realistic illustration of the Yeti is finished. If you feel it is a bit tricky to create the background in this way you could paint the picture directly onto the background and apply Gaussian Blur. But that isn’t as much fun (Fig.12 – 13).

Weiye Yin
For more information please visit:
http://www.franc-art.com
Or contact them at:
francwork@163.com
Painting Myths & Legends

Chapter 05 | Alien

Software used: Photoshop & Painter

For this tutorial my goal was straightforward and clear: “paint a realistic alien”. All the specifics of the piece were left to me. Such a vast playing field may be a bit daunting, so to get a few ideas I started to set up a mood-board for inspiration.

A mood-board isn’t a collection of images used for reference as they are, rather it is an inspirational tool aimed to set the mood for a given piece and provide starting points. I had already decided that my alien would be humanoid and female, and was inclined to set her in a water environment. I wanted her to feel believable, and so started to assemble inspirational images regarding sea creatures and plants, from kelp to sea anemones and lionfish.

Using the mood-board photos as a raw conceptual base, I started sketching some very rough concepts, mixing and matching features, shaping and changing it until I found a combination that “clicked” with my idea of an alien living in a warm water world. At that point I took the concept sketch and refined it into the line art. Some details, like the pattern on the alien’s skin for instance, won’t appear until a later phase of the work. I usually don’t do very detailed drawings, but rather use them as a simple base for the color work. I also didn’t draw a background, since for this piece the background was to be very simple. I blocked it in later, directly in color (Fig.01).

Then I imported the Photoshop line art into Painter 11 for the first step of the color phase. I like how Painter mimics traditional media and sets a natural-looking base texture, which helps to avoid the “artificial” digital look.

I use Oils and Artist’s Oils brushes for my color bases. For the color blocking-in I work with the Round Camel Hair brush (from the Oils set), the Wet Oily Palette knife (from Artist’s Oils) and the Glazing Round brush (from Oils). For my final pass in Painter I use the Sharp Triple Knife from the Palette Knife set; it is an interesting brush I use to create a strong base texture, as shown in this detail (Fig.02).

All these brushes are used with the standard Painter 11 settings, with the exception of Opacity which I adjust according to my needs (it generally goes from 30% to 60%), and of course the tip size which (it goes without saying) varies according to the size of the element I’m working on.

In this phase, working on a single layer, I blocked-in the colors (including the background...
for the alien) and defined basic volumes and shadows. All of my swatches are already present in the image (Fig.03).

When I went digital, four years ago, my Painter step used to be shorter and rougher. Nowadays I tend to expand and refine it more, taking advantage of its almost traditional flavor, although I don’t envision working exclusively in it.

The blocking-in was done so I imported the file into Photoshop (I work with Photoshop CS4, to be precise – being able to rotate the canvas is a very handy option in my opinion). There I copied the alien onto her own layer, and also selected and copied her costume/harness and hair on different layers.

You may notice that a part of her harness disappeared in the previous step. That was done on purpose, given that those leather straps are in front of everything else and I was thinking about changing the design. I left them out of the blocking-in phase and inserted them directly in the first Photoshop step, on their own layer (Fig.04).

I like to use a hard elliptical brush to define edges and shapes (brush #6) set at 82% opacity and 100% flow. In Other Dynamics, Opacity Control and Flow Control are both set to Pen Pressure and Opacity Jitter is at 40%. I always set my brush sensitivity to Pressure, both for tip size and opacity and flow.

Now it was time to start the texturing of the alien and her equipment, differentiating the materials. In my work process all the textures are painted. Years ago I experimented with integrating photographic textures in my illustrations, but wasn’t very happy with the results. In a few cases dealing with very simple shapes, no matter how much I fiddled with them, photographic textures just didn’t work for me.

I was careful not to completely smooth away the base texture I had created with the Palette Triple Knife. The idea is for the two layers of texture to blend together. In my work textures are always layered, I work on the same material with different brushes at different stages, combining them in such a way that the different visual properties are perceivable. In Fig.05 are samples of all the Photoshop brushes I used.

The brushes I use for texturing always have flow set to 100% and opacity goes from 20% to 70%. I think that having a strong random element in a texture makes it more visually interesting, hence in my brushes the Shape Dynamics and the Angle Jitter is between 10% and 15% and set to Control: Direction. Opacity and Flow Controls are set to Pen Pressure.
All the brushes I used for texturing (apart from #4) are custom brushes I gathered, or made through experiments. I often try out new brushes, mixing and matching different ones and studying the results. It is better, in my opinion, not to let oneself be limited by a brush's name or the way a specific illustrator uses it. One of the most effective brushes I ever found to give a subtle texture to human skin, for instance, was originally created to paint dry, cracked mud (Fig.06).

Given that water is much denser than air, and the background elements are both submerged and relatively far, I've chosen to use a single texturing brush for the background (#5), instead of the different, specific ones used for the figure. In this way the illusion of depth is enhanced.

Depth is also important for the alien's tentacle-like hair. The part nearest to the observer has the strongest texture, while the receding elements have a lighter texture, or tend to become more indistinct as their value and texture get nearer to that of the sea water surrounding them. For this reason, I have used brush #5, set at a low level of opacity (30%), to texture the tips of the hair/tentacles. At this point I also added some fish to give more life to the background, and painted in the two floating beacons/communication devices at the alien's sides (Fig.07).

Natural textures are never uniform. Skin is softer in some regions, and drier, more fragile or callused in others depending on work, health and previous injuries. Scar tissue is shinier than normal skin pores and may be more evident in some places and so on. At this point I worked on the previously painted textures, using a standard round soft brush at 25% opacity to soften the texture in places, specifically the shoulders and breasts.

I also worked on the yellow spots, making the central point of each spot brighter, giving them a slight luminescence. I also painted some
fainter spots on the bone forehead plaque by selecting the desired shapes with the Lasso tool and adjusting the color balance towards yellow (Fig.08).

For the final texturing of the forehead I made two different layers. On one I used brush 1b in Soft Light mode. On the other one I used a standard speckled brush in Color Dodge mode.

I refined the harness design and adjusted the lights, considering the two additional light sources now present. I took advantage of them by making one warm and the other cold. Two different light temperatures are very important to help define volumes and make them more three-dimensional.

The final refining step is when I work on decoration. Elements like ornate hems, tattoos, body painting and the like are added at this
stage. My key instrument for this is the Selection tool, which I employ to create digital templates.

To create ornamented hems on the bra, I selected it and moved the selection in such a way to leave out of it a strip of the garment (Fig.09). Then I used brush #3b to paint a light cast shadow along the “marching ants” line to give the impression of a thicker hem. Then I refined the internal edge (the “furrow”, if you wish) with the hard elliptical brush I used to define edges at the very beginning (#6).

In order to create etchings I don’t use Photoshop’s Layer Styles (specifically Bevel and Emboss), because the program obviously applies the styles in a uniform, mechanical way. The results feel rather artificial and because of all this I found using a different way is faster.

On a new layer I drew the desired decoration with a round hard brush (depending on the kind of decoration one can also use a vector pattern). Once done this layer will be used only as a Selection tool (Fig.10). I turned the “etching base” layer off and selected it, then I copied and pasted the selection from the under layer (it will not be visible at this point), before altering the color or the levels of the pasted selection. I did this operation twice, once with a dark color (the shadow) and once with a lighter one (the light). The two layers aren’t exactly superimposed, of course, I kept them a few pixels off one another depending on which side the light is coming. Then I refined the decoration working with the Eraser, the Smudge tool and the usual #6 brush.

For the bra decoration I used a vector pattern (Fig.11). I copied it onto its own layer, just like I did for the forehead decoration, adjusting the length and shape to the surface I wanted to decorate. I used this layer as a Selection tool.

With the selection active (Fig.12) I went to Select > Modify > Border and gave it a value of 4 pixels. With this new selection active I copied and pasted from the underlying layer (the bra) and changed the layer property to Multiply. Then, with the selection of the base pattern active again, I went to Select > Modify > Contract and once again select 4 pixels as the value. Again I copied and pasted from the bra layer, this time giving it Color Dodge as a layer property. I then merged down all the new layers on the bra and I worked on the decoration with brush #6 and brush #3b to give the decoration the slightly irregular and hand-made look.
Using this procedure and experimenting with different layer properties it is possible to obtain different results (see, for instance, the two leather straps coming down from the bra; there I used Soft Light and Screen instead of Multiply and Color Dodge).

In my opinion at this point something was still missing. I wanted some light, natural elements to frame my alien to both guide the viewers’ eyes and enhance a feeling of “otherness”, so I painted in some kelp fronds and air bubbles (Fig.13). Then I added a subtle halo around the light sources (again, with a texturing brush, #3b, not a soft brush).

As a last touch I created a new layer above all other layers and filled it with the background blue, put it in Soft Light layer mode at 40% opacity and 40% fill, so that the alien would have a tinge of the background and so it didn’t appear as if she was standing in front of an aquarium.

Just this wasn’t enough, though, so I created a new layer and made a gradient: deep blue to transparent from bottom left to top right, and set it to Hard Light mode. I then created another layer and I painted in some plankton and matter particles with a speckled brush. This is the result (Fig.14).
Tiziano Baracchi

For more information please visit:
http://www.tizianobaracchi.com

Or contact them at:
eginardus@hotmail.com
When the Loch Ness Monster is mentioned people immediately associate it with a black and white silhouetted photo of a monster on a sparkling water surface, with a sea serpent-like head.

People have been fascinated by the Loch Ness Monster since 565 AD. Although most of the persuasive photos have now been proved as being fake, people’s belief in the beast has not been impaired at all.

Whether the Loch Ness Monster is a legend or just an unlocked mystery, fantasy and expectancy in people’s heart will always exaggerate any existing ideas about what the creature is. As fantasy artists we can draw this legendary creature with our pen and combine tales we have heard with our imagination, and show the Loch Ness Monster we have in our mind.

According to blurred photos and the descriptions of witnesses, the Loch Ness Monster could be described as a creature like a “Plesiosaur” (the plesiosaur is a marine reptile that lived in the Jurassic age). Images show that the Loch Ness Monster seems to float on the water’s surface, revealing its long neck and huge ridge, which is different from a plesiosaur. Whether this is a habit of the Loch Ness Monster or not, it has become a symbol of the monster. This appearance has left a deep impression on people and will be considered in this image.

Before working on the illustration I find it helps to draw a sketch to define the features of the Loch Ness Monster for reference later. To control the features and shape better I draw a plesiosaur as a prototype base (Fig.01).

The next step is to add some reasonable fantasy elements on the plesiosaur to make it more like the Loch Ness Monster. By reasonable I mean not too exaggerated. I say this because features of the monster might become impaired. For example, too large a horn or dorsal fin will change the basic outline which has left a deep impression on people.

I add fantasy elements such as the gill fins of a dragon, scales covering the whole body, a wing like ventral fin and a beautiful tail fin. I do this to add a mythical atmosphere to the mysterious creature. Although these elements don’t change the outline of the plesiosaur obviously, it does become difficult for audiences to associate the Monster with a plesiosaur, therefore making it different (Fig.02).

Do not start the sketch for the illustration in a hurry after the shape is finalized. The structure of a marine creature is very special because of the control and dynamic needed in the water.

The illustration’s content has been decided upon already, as we want the Loch Ness Monster’s
head and neck to be exposed as it is shown in photos and described by witnesses. In this case the limbs and trunk would be under water which affects the overall dynamic and position of the monster’s features. To express this all accurately it is worth doing a few practice sketches.

For the final composition I choose a gesture that doesn’t only show the dynamic of the monster in the water, but also avoids a potential problem. By curving the neck I can display the monster’s face from the side rather than the front (Fig.03).

The next step is to decide on the final composition for the illustration (Fig.04).

It won’t be a waste as you can save the part that you don’t need, but those parts need to be hidden temporarily or saved as another file so they don’t influence the normal layout. I will tell you what to do with the cut part at the end of this tutorial.

Now we can begin work on the formal illustration. First paint a background, which in this case will be the peaceful Loch Ness (Fig.05). Loch Ness is the largest freshwater lake in the north part of the Scottish highlands. Because of this we must include a few things like an open lake surface, surrounding mountains and mist and clouds. By doing this we show those that view the image the type of location that the monster is in.

Please pay attention to your layers in the layout stage. Take Fig.06 as an example:

- **Layer A** is the foreground, where the main scenery and character of the illustration will be depicted.
- **Layer B** is the mid-ground. Its role is to help put the character in the scene. This area should have some points of interest. In this case I have put in Urquhart Castle, which is on the shore of the Loch Ness.

- **Layer C** is the far mid-ground, which enhances the sense of spatial distance and connects the lake to the back-ground.

- **Layer D** is the background, which continues to add to the sense of depth and scale.

Here is the render after the first sketch is finished (Fig.07).

When you come to painting the water it is important to remember how the monster will affect the water around him. The sky is painted to look typically Scottish with heavy cloud cover. The sunlight therefore shines on the water’s surface through the clouds.

The next step is to work on the details. I have separated the character and its environment to help show the changes more clearly. We will look at the head and neck of the monster as an example (Fig.08). Firstly complete the basic structure of the character and show the way the light hits him. This can be done in black and white. Then add important details such as the scales, eyes and teeth. Such important details are not required to be very precise, but all the key features must be presented accurately and clearly. Then the color can be added.

The scales are important to get right and should wrap around the trunk and limbs. If the arrangement of the scales is wrong the overall structure of the animal depicted will be impaired (Fig.09). You can use the “Lattice method” to draw guide lines to determine the trend of...
scales. You can see that the flow and direction of the scales is indicated by red and green arrows in the image. In the second image you can see the next set of lines to add indicated with a blue arrow. By adding these you should have the required guides to continue to develop your scales. These lines should overlap.

The next step is to refine the lattice. Over these guides you can start to add the shadows and highlights, and then add color and volume to make every scale stand out (Fig.10).

You can use the same technique for the back of the monster. Scale, direction and general movement rules should be paid attention to as they were with the neck. You can see the development of the scales in A – C in Fig.11.

Giving the scales a quality feeling is the easiest way to make the monster look moist. Please note that the highlight on the monster should not be shown individually on every scale, but should be shown on its overall structure.

At this point let’s go back to the background to develop it. Reduce the amount of detail painted as you move further away from the foreground. This will add to the sense of depth (Fig.12).

There aren’t many details to be painted on the mountains as they are far away, but don’t forget to pay attention to the overall lighting to enrich the image (Fig.13).
Here’s the image after the background is completed (Fig.14).

The water’s surface in this scene is close to the viewer so it should look as detailed as the main character. I use cyan as the main tone for the water’s surface. It adds a cool feeling to the image and contrasts with the background of warm colours. I have lit the water from behind as it will mean that the splashes can be highlighted and this will help blend the character in the scene. Try not to make the colors dirty when painting the water’s surface. Use fairly pure colors even for areas in shadow (Fig.15).

Paint waves and splashes that look as though they are reacting with the movement of the monster. I am using pure white here to do this. Also don’t forget the droplets from his head, neck and tail (Fig.16).

Add a misty effect and halo to the lake’s surface to enrich the atmosphere (Fig.17).

I’d like to share a solution with everyone who thought it was a shame to cut part off at the beginning. You could paint the illusion of being under the water’s surface in the part you cut off. The underwater parts should be vague so strong contrasts can be formed with effect above the water’s surface (Fig.18):

- Paint caustics effects on the trunk and limbs near the water’s surface to make the image more real
- Separate the whole image into upper and lower parts with ripples
- The trunk and limbs below the water’s surface should be a little larger and dislocated so they imitate deformation caused by refraction in the water.
This eBook series will be split over six separate chapters, all sharing the common theme of a fantasy inspired medieval scene. Each will be undertaken by a different artist and draw upon a wealth of experience and skills perfected over years of industry practice. The authors will discuss their approach to digital /concept painting, the tools and brushes they employ and treat us to a valuable look into their artistic process. The six installments will cover a different environment each chapter based upon the medieval theme and encompass a multitude of professional tips and techniques.

Original Author: 3DTotal.com Ltd | Platform: Photoshop, ArtRage & Painter | Format: DOWNLOAD ONLY PDF
Futuristic cities and landscapes dominate digital art. They form the backdrop of countless films and videogames and give artists an opportunity to explore the boundaries of their imagination. This is more than just a design based eBook though as each tutorial is filled with advice and tips that could help any artist develop and grow. This tutorial series is made up of six chapters, each tackled by a different artist, will be exploring the ways to design and paint cities of the future. Each artist will draw upon years of experience to demonstrate techniques and methods for creating original designs in a step by step way that can help any digital artist.

Original Author: 3DTotal.com Ltd | Platform: Photoshop | Format: DOWNLOAD ONLY PDF
This eBook tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using a set of intuitive tools.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing to draw complicated scenes, this approach can prove a valuable starting point for producing a template on which to paint over.

Original Author: 3DTotal.com Ltd | Platform: Google SketchUp & Photoshop | Format: DOWNLOAD ONLY PDF
This eBook series will be split over six separate chapters all of which will be dedicated to painting monsters suited to a range of habitats spanning jungle and aquatic to mountainous and subterranean. Each will be covered by a different author who will discuss their approach to digital/concept painting, the tools and brushes they employ and how to create a final image. We shall gain an insight into the thought processes of each of our industry professionals and the ways in which they develop an idea from concept sketches through to a finished work.

Original Author: 3DTotal.com Ltd | Platform: Photoshop & Painter | Format: DOWNLOAD ONLY PDF